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1. Related Manuals

SOLUTION

1. Related Manuals
To ensure system safety, make sure to always read and follow the information provided in all
Safety Precautions and Precautions for Safe Use in the manuals for each device which is
used in the system.
The table below lists the manuals provided by MARS TOHKEN SOLUTION CO.LTD.
(hereinafter referred to as “MARS TOHKEN SOLUTION”) and OMRON Corporation
(hereinafter referred to as “OMRON?”), which pertain to this guide.
Manufacturer | Cat. No. Model Manual name
OMRON W472 CJ2M-CPUI][ CJ Series
CJ2H-CPUG[] CJ2 CPU Unit
CJ2H-CPUBG[]-EIP Hardware USER'S MANUAL
OMRON W473 CJ2M-CPUI][ CJ Series
CJ2H-CPUg[] CJ2 CPU Unit
CJ2H-CPUBG[I-EIP Software USER'S MANUAL
OMRON W336 CJ1W-SCUI[J1-V1 CJ Series
CJ1W-SCUJ]J2 Serial Communications Units
OPERATION MANUAL
OMRON W474 CJ2[]-CPUIIN CJ Series
Programmable Controllers
INSTRUCTIONS REFERENCE MANUAL
OMRON W446 CXONE-AL[][IC-V4 CX-Programmer
/ AL[J[ID-V4 OPERATION MANUAL
MARS - MVF-300 Operation Manual MVF-300 Series
TOHKEN Fixed mount 2D Image Reader

3" Edition




2. Terms and Definitions

2. Terms and Definitions

Term

Explanation and Definition

PLC link

A function which enables a MARS TOHKEN SOLUTION image reader to
directly read or write data to PLC data memory by connecting a PLC to the
image reader through RS-232C or LAN interface.

This eliminates the need to create a communication program and cuts the
time required for programming.




3. Precautions

3. Precautions

(1)

Understand the specifications of devices which are used in the system. Allow some
margin for ratings and performance. Provide safety measures, such as installing a safety
circuit, in order to ensure safety and minimize the risk of abnormal occurrence.

To ensure system safety, make sure to always read and follow the information provided in
all Safety Precautions and Precautions for Safe Use in the manuals for each device
which is used in the system.

The user is encouraged to confirm the standards and regulations that the system must
conform to.

It is prohibited to copy, to reproduce, and to distribute a part or the whole of this guide
without the permission of OMRON Corporation.

The information contained in this guide is current as of February 2017. It is subject to
change for improvement without notice.

The following notations are used in this guide.

Indicates a potentially hazardous situation which, if not avoided,

A Ca Utl on may result in minor or moderate injury or property damage.

IE' Precautions for Correct Use

Precautions on what to do and what not to do to ensure proper operation and performance.

@ Additional Information

Additional information to read as required.
This information is provided to increase understanding or make operation easier.

Symbol

The triangle symbol indicates precautions (including warnings).
The specific operation is shown in the triangle and explained in the text.
This example indicates a general precaution.




4. Overview

4. Overview

This guide describes procedures for connecting a MARS TOHKEN SOLUTION MVF-300/500
series Fixed mount 2D Image Reader (hereinafter referred to as the “Image Reader”) to an
OMRON CJ-series Programmable Controller + Serial Communications Unit (hereinafter
referred to as the “PLC”) via serial communications, for using PLC link for Image Readers and
for checking their communication status.

Refer to Section 6. Serial Communications Settings and Section 7. Serial Communications
Connection Procedure to understand setting methods and key points to perform serial
communications and to use PLC link for Image Readers.

The operation specifications of the Image Reader with PLC link are shown below.

The Image Readers read a code by reading or writing the following PLC data memory.

In this guide, the Image Reader reads or writes the PLC data memory at the start address
"D01000" and reads the two-dimensional code (2D code) which is described in 7.4.2.
Checking the Sent and Received Data.

Address Area name Area description
D01000 Trigger area Area to trigger the Image Reader to start reading
D01001 -
: Reserved
D01008

Area for the number of | Area to store the number of digits of read data
D01009 | . =

digits of read data

D01010 Area to store read data

: Read data area

D01033

The Image Reader reads a code in the following order.

(1) The PLC writes 1 in the "Trigger area”.

(2) The Image Reader starts reading a code.

(3) After reading the code, the Image Reader stores the read data and the number of
digits of read data in the "Read data area" and the "Area for the number of digits of
read data", respectively.

(4) The Image Reader clears the "Trigger area" to zero.

@ Additional Information

Contact MARS TOHKEN SOLUTION CO.LTD. for more details on operation specifications of
Image Readers with PLC link.



5. Applicable Devices and Device Configuration

5. Applicable Devices and Device Configuration

I 5.1. Applicable Devices
The applicable devices are as follows:

Manufacturer Name Model
OMRON CJ2 CPU Unit CJ2[]-CPUI
OMRON Serial Communications Unit CJ1W-SCUI[J1-V1

CJ1W-SCUJ[]2
MARS Image Reader MVF-500]]
TOHKEN MVF-300[][0]
SOLUTION

IE' Precautions for Correct Use

In this guide, the devices with models and versions listed in 5.2. Device Configuration are
used as examples of applicable devices to describe the procedures for connecting the
devices and checking their connections.

You cannot use devices with versions lower than the versions listed in 5.2.

To use the above devices with models not listed in 5.2. or versions higher than those listed in
5.2., check the differences in the specifications by referring to the manuals before operating
the devices.

@ Additional Information
This guide describes the procedures for establishing the network connections.
It does not provide information on operation, installation, wiring method, device functionality,
or device operation, which is not related to the connection procedures.
Refer to the manuals or contact the device manufacturer.



5. Applicable Devices and Device Configuration

I 5.2. Device Configuration
The hardware components to reproduce the connection procedures in this guide are as

follows:
Personal computer CJ2M-CPU12 +
CX-One, MVFConfi
i(nstalled, ° CJIW-SCU42 MVF-300
OS: Windows 7 . .
) USB cable ﬂn :
AA000122J_ —
P . Serial cable °
&55E (RS-232C) TPSU-3200-24V
NBC-MSX/5,0-94F/R4AC SCO
Manufacturer Name Model Version
OMRON Serial Communications Unit | CJ1W-SCU42 Ver.2.0
OMRON CPU Unit CJ2M-CPU12 Ver.2.0
OMRON Power Supply Unit CJ1W-PA202
OMRON CX-One CXONE-AL[][IC-V4 Ver.4.]][]
/AL[][ID-V4
OMRON CX-Programmer (Included in CX-One) Ver.9.52
- Personal computer -
(OS: Windows 7)
- USB cable -
(USB 2.0 type B connector)
- Serial cable (RS-232C) -
MARS Image Reader MVF-300 System version:
TOHKEN M66C-V2.4i'
SOLUTION Decode version:
M66A-V2.42
MARS LAN cable for MVF series NBC-MSX/5,0-94F/R4AC
TOHKEN SCO
SOLUTION
MARS MVF-300 AA000122
TOHKEN Image reader cable
SOLUTION
MARS Power Supply Unit TPSU-3200-24V
TOHKEN
SOLUTION
MARS MVFConfig - Ver.1.4.12
TOHKEN
SOLUTION

*1. The MVF-300 series can be used with the system version M66C-V2.4b or a higher version.
The MVF-500 series can be used with the system version M53C-V1.0a or a higher version.

*2. The MVF-300 series can be used with the decode version M66A-V2.4b or a higher version.
The MVF-500 series can be used with the decode version M53A-V1.0a or a higher version.

*3. The model number of the image reader cable for MVF-500 series is AA0O00100.



5. Applicable Devices and Device Configuration

IE' Precautions for Correct Use

Update CX-Programmer to the version specified in this Clause 5.2. or to a higher version.

If you use any version other than the one specified in this guide, the procedures described in
Section 7. and subsequent sections may not be applicable. In that case, use the equivalent
procedures described in this guide by referring the CX-Programmer OPERATION MANUAL
(Cat. No. W446).

Additional Information

For information on the serial cable (RS-232C), refer to 3-4 RS-232C and RS-422A/485
Wiring of the CJ Series Serial Communications Units OPERATION MANUAL (Cat. No.
W336).

Additional Information
Contact MARS TOHKEN SOLUTION CO.LTD. for specifications of the power supply unit.

Additional Information

The system configuration in this guide uses a USB for the connection between the personal
computer and the PLC. For information on how to install the USB driver, refer to A-5 Installing
the USB Driver in Appendices of the CJ-series CJ2 CPU Unit Hardware USER'S MANUAL
(Cat. No. W472).



6. Serial Communications Settings

6. Serial Communications Settings

This section describes parameters (including the PLC data memory allocation) and wiring that

are all defined in this guide.

I 6.1. Parameters

The following shows the parameters required for connecting the PLC and the Image Reader
via serial communications and for using PLC link for Image Readers.

6.1.1. Communication Settings between Personal Computer and Image Reader
In this guide, the parameters of the Image Reader are set on the personal computer via
Ethernet communications.

Setting item

Personal computer

Image Reader

IP address

192.168.209.1

192.168.209.10 (Default)

Subnet mask

255.255.255.0

255.255.255.0 (Default)




6. Serial Communications Settings

6.1.2. Communication Setting between Serial Communications Unit and Image

Reader
Serial Image Reader
Setting item Communications ;
Unit Set value Setting

Unit number 0 - -
Communications Port 2 - -
(Connection) port
Serial communications | Host link - -

mode

Baud rate 9600bps (Default) | 9600bps (Default) -

Data length 8 bits - -

Parity None - -

Stop bits 1 bit - -

Frame - 8N1 (Default) Data length: 8 bits
Parity: None
Stop bit: 1 bit

CTS control (RS/CS) No OFF (Default) -

1:N/1:1 protocol setting | 1:1 protocol -

232/422 selector switch

RS232

Select port

RS-232C (Default)

Output destination of data
read by the Image Reader:
RS-232C

Address - 1000 Start address of the data
memory: D01000
Mode (PLC link mode) | - SysMacCXRS232C | Connection destination of

the Image Reader:
OMRON SYSMAC series
Interface to use for
connection: RS-232C

Padding

Null (Default)

Padding character: 0x00

Time

10 (Default)

Wait time of trigger area
monitoring time: 10s

Trigger area interval

10 (Default)

Trigger area monitoring
time: 10ms

Trigger area sync

ON (Default)

SYNC IN by trigger area:
Enable




6. Serial Communications Settings

I 6.2. Cable Wiring

For details on cable wiring, refer to SECTION 3 Installation and Wiring of the CJ Series Serial
Communications Units OPERATION MANUAL (Cat. No. W336).
Check the connector configurations and pin assignments before wiring.

mConnector configurations and pin assignments
CJ1W-SCU42 Serial Communications Unit applicable connector: D-sub 9-pin female

Pin No. | Symbol Signal name I/O

1 FG Shield -
2 SD Send data Output
3 RD Receive data Input
4 RS Request to send Output
5 CSs Clear to send Input
6 5V Power supply -
7 DR Data set ready Input
8 ER Data terminal ready Output
9 SG Signal ground -

Shell FG Shield -

TPSU-3200-24V Power Supply Unit applicable connector: D-sub 9-pin male

Pin No. | Symbol Signal name 1/0

1 NC - -

2 RXD | Received data Input 6 1
(RS-232C) y:

3 TXD | Transmitted data Output ° °
(RS-232C) o :

4 NC - - * o

5 SG Signal ground - 9 5

6 NC - -

7 RTS | Transmission request Output
(RS-232C)

8 CTS | Transmission Input
permission (RS-232C)

9 NC - -

10



6. Serial Communications Settings

mCable and Pin assignments

Serial Communications Unit Power Supply Unit
(CJ1W-SCU42) (TPSU-3200-24V)

RS-232C | Signal | Pin No. Pin No. | Signal RS-232C
Interface | name name Interface
FG 1 1 NC
SD 2 2 RXD
RD 3 3 TXD
RS 4 4 NC
CS 5 5 SG
5V 6 6 NC
DR 7 7 RTS
ER 8 8 CTS
SG 9 9 NC

FG Shell e D-sub 9-pin
D-sub 9-pin Cable connector type: Female
Cable connector type: Male

11



7. Serial Communications Connection Procedure

Serial Communications Connection Procedure

This section describes the procedures for connecting the PLC to the Image Reader via serial

communications and for using PLC link for Image Readers. The explanations of the

procedures for setting up the PLC and the Image Reader given in this guide are based on the

factory default settings. For the initialization, refer to Section 8. Initialization Method.

| 7.1. Work Flow

Take the following steps to connect the PLC to the Image Reader via serial communications

and to use PLC link for Image Readers.

7.2. MARS TOHKEN SOLUTION Image

Reader Setup

|

7.2.1. Hardware settings

!
7.2.2. Parameter Settings
!
7.3. PLC Setup
!

7.3.1. Hardware Settings

!

7.3.2. Starting CX-Programmer and
Going Online with PLC

|

7.3.3. Creating the 1/0O Table

|

7.3.4. Parameter Settings

!

7.4. Serial Communication Status

Check

!

7.4.1. Checking the Connection Status

|

7.4.2. Checking the Sent and
Received Data

Set up the MARS TOHKEN SOLUTION Image
Reader.

Set the hardware switches on the Image Reader
and connect the cables.

Set the parameters for the Image Reader.

Set up the PLC.

Set the hardware switches on the Serial
Communications Unit and connect the cables.

Start CX-Programmer and go online with the PLC.

Create the 1/O table for the PLC.

Set the parameters for the Serial Communications
Unit.

Confirm that serial communications and PLC link
for Image Readers perform normally.

Check the connection status of serial
communications.

Check that the correct data are sent and received
using PLC link for Image Readers.

12



7. Serial Communications Connection Procedure

I 7.2. MARS TOHKEN SOLUTION Image Reader Setup
Set up the MARS TOHKEN SOLUTION Image Reader.

7.2.1. Hardware Settings
Set the hardware switches on the Image Reader and connect the cables.

IE' Precautions for Correct Use

Make sure that the power supply is OFF when you set up.
If it is ON, the settings described in the following steps and subsequent procedures may not
be applicable.

1 Make sure that Power Supply
Unit is powered OFF.

2 Check the position of the T Scanner connector
connectors on the front of Image {é n é %
Reader by referring to the figure L2

— LAN connector
on the right. On the front of Image Reader

3 Connect LAN connector and
Personal computer with LAN
cable for MVF series.

|| LAN cable for MVF series

]
Lo Personal computer

4 Check the positions of the AC inlet RS.232C 232/422 selector

hardware switches and the / connector switch
ConneCtorS On the rear Of Power @ AC INPUT ILLUM bio \Il R RS232 RS422 I
Supply Unit. N\
Q@ BNG @
ILLUMZ .
= ® B T ©
(@]
7 1
Power supply switch IMAGER connector
On the rear of Power Supply Unit
5 Set 232/422 selector switch to SW
RS422
6 Connect IMAGER connector on mgsﬂ
Power Supply Unit to Scanner W— Image reader cable
connector with Image reader = ' ®
|
cable. 0
7 Connect a Serial cable Rsz32
(RS-232C) to RS-232C Serial cable (RS-232C)
o
connector.

13



7. Serial Communications Connection Procedure

7.2.2. Parameter Settings
Set the parameters for the Image Reader.
The parameters are set in “MVFConfig” software.
Install the software on your personal computer beforehand.

@ Additional Information
Contact MARS TOHKEN SOLUTION CO.LTD. for information on how to install MVFConfig.

1 Turn ON Power Supply Unit.

14



7. Serial Communications Connection Procedure

2 Setthe IP address of Personal Dialog box in (2)

L Local Area Connection Stzm.l- ﬂ

computer to 192.168.209.1. Z
General
*The IP addl’eSS can be Connection
Changed |n the fo”own‘]g Way IPv4 Connectivity: Mo network access
IPv& Connectivity: No network access
Media State: Enabled
(1)Start Personal computer and Duration: 00:25:04

log in using an administrator Speed: 1.0 Ghps
account. From the Windows

Start menu, select Control
Panel - Network and

Internet - Network and e _

Sharing Center, and click A Received
Change Adapter Settings. . @ .
Double-click Local Area '

Connection.

I@Eroperﬁes” @Qisable H Diagnose ]

*The operation procedure
may differ depending on the |
environment of your personal Dialog box in (3)
computer. m mcalm =

Networking | Sharing

Connect using:

(2)The Local Area Connection
Status Dialog Box is
displayed. Click Properties.

‘-'-." Intel{R) 82579LM Gigabit Network Connection

(3)The Local Area ConneCtion This connection uses the following items:

. . . 0% Client for Microsoft Networks
Propertles Dlalog Box is BQOS Packet Scheduler

dIS |a ed Se|eCt Internet File and Printer Sharing for Microsoft Networks
Y
Protocol Version 4 b
(TCP/IPv4), and click Intemet Protocol Version 4 (TCP/IPyd
Pro p ert | es. i Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topology Discovery Responder
*The display may differ ___
depending on the Descrption

. 7 Transmission Control Protocol/Intemet Protocol. The defautt
ConflgU rat|0n of yOU r wide area network protocol that provides communication

personal com puter across diverse interconnected networks.

(4)The Internet Protocol Version Cance

4 (TCP/IPv4) Properties ~ :

Dialog Box is displayed. ?:alggmfi:%ﬂm@g

Select Use the following IP

address, and set the IP Generd

’?hddresbs t?[ 192. &?8-209-1 and oty s o e 1025k ot vk s
e subnet mask to

for the appropriate IP settings.
255.255.255.0. Click OK.

() Obtain an IP address automatically
I @ Usge the following IP address: I

(5)Click Close or OK to close all [P address: 122 . 160 208 . 1
the displayed dialog boxes. Subnet mask: 25 285 258 0
Default gateway:

Obtain DMS server address automatically
@ Use the following DNS server addresses:

Preferred DNS server:

Alternate DNS server:

[T validate settings upon exit

15



7. Serial Communications Connection Procedure

displayed in the Address
Column of Image Reader in the
Image Reader and Main
configuration Pane.

Click Connect.

The message on the right is
displayed after Personal

computer and Image Reader are

connected normally.

3 Start MVFConfig on Personal :
computer. -ﬂ
MVFConfig
4 MVFConfig starts. [icde Sclectay == x|
The Mode Selector Window is OO O O T T T T
displayed. ",u lll "dlll| I'l l “ﬁ
_ easy advance(
Click advanced. TRTIRTIN
Easy Advanced
(Settings can be easily) (Settings can be in detail)
YT “'“\"\-.._”
IIHI THYTETYRY
Close
5 The MVF Config Window (detalil 4 Image Reader and Main | | Configuration |
configuration) is displayed. configuration Pane Sub-Pane
The following panes are used to
explain the parameter settings
and the initialization settings in
this guide.
Left: Image Reader and Main
Configuration Pane - — s
Right: Configuration Sub-Pane S — -
(Detail configuration)
6 Check that 192.168.209.10 is

2 Image Reader

@ Register @ Delete

Connect| %5 Disconnect

Reader Name

Connected

192.168.209.10

16



7. Serial Communications Connection Procedure

7 The dialog box on the right is
displayed. Check the contents
and click Yes.

Load configuration from the scanner?

The message on the right is
displayed after the configuration
is read.

Read configuration done
8 The mark (connection

2 Image Reader
status) is displayed in the Status

Column of Image Reader. © Register @ Delete %, Connect %5 Disconnect
Click Common.

Status Reader Name Address
S MVF 192.168.209.10

mage Reader
in Common are displayed. % ag -
Click Communication. = Common

SSommunication

*Read Operation
*Image Settings
D utput Settings
‘Preset

- LAN

-PLC

17



7. Serial Communications Connection Procedure

10 The configuration items of

Communication are displayed.

Select the following values.
Baudrate: 9600bps
Frame: 8N1
RS/CS: OFF
Select Port: RS-232C

2 Image Reader - MVF

= Common

< Communication

Baudrate
Frame
Header
Terminator
Command Format
Separator
Prefix
PrefixChar
Suffix

Suffixx Char
RS/CS
TCP/C
Select Port
Control Code

Timeout

- Read Operation

9600bps

8MN1

[MNUL]

[MNUL]

R5-232C

Through

1000ms

18



7. Serial Communications Connection Procedure

11 Click PLC listed in Common.

# Image Reader

= Common

TCRAC
Select Port
Control Code
Timeout
> Read Operation
* Image Settings
s Qutput Settings

s Preset

s LAN

FPLO

R5-232C v
Through v
1000ms

2l

12 The configuration items of PLC

are displayed.

Select the following values.
Address: 1000
Mode: SysMacCXRS232C
Padding: Null
Time: 10
Trigger Area Internal: 10
Trigger Area Sync: ON

2 Image Reader

= Common

aPLC
F Address
Part Mo
Address
Endian
hode
Paddine

Time

Triggerfrea Svnc

Triggerérea Interval

192.168.000010

9600

1a0a

Little b

SysMacCHRS2: w
Mull v
10

11

Fon o I

O

13 Select Write Config from the
Reader Menu.

[

Reader ] Wiew

System Tool

& Read Config
L. Write Config

L. Save Config

Ctrl+F1
Ctrl+F2

Ctrl+F3

-_—

9



7. Serial Communications Connection Procedure

14 The dialog box on the right is

displayed. Check the contents
and click Yes.

The message on the right is
displayed after the configuration
is written.

Write configuration to the scanner?

Write configuration done

15 Select Save Config from the Reader View stem Tool
Reader Menu. ;] =
& Read Config Ctrl+F1
*If you do not save the X, Write Config Ctrl+F2
configuration, the data
configured on Image Reader & Save Cenfig Ctrl+F3
are not stored in the
non-volatile memory of Image
Reader, and they will be
discarded when you turn OFF
Power Supply Unit.
The dialog box on the right is ~ .
16 displaye dg Check the coiten s Save configuration to the scanner?
and click Yes.
The message on the right is 5 )
displayed after the configuration Saved the scanner configuration
is saved.
: , -
17 Select Exit from the File Menu &8 MVF Cunﬁg_

to close the MVF Config
Window.

Edit Reader

= Open Ctrl+0

Save Ctrl+5
Save As...

= Exit Chrl+X

20



7. Serial Communications Connection Procedure

18 Click Close in the Mode - mEEE
Selector Window.

ulil IIIII\ III III III |

easy dvanced
ARALAL

Easy Advanced
(Settings can be easily) (Settings can be in detail)
YT WAL

Il ||||| (]

Close

19 Turn OFF Power Supply Unit.

*After PLC is connected to
Image Reader in 7.3. PLC
Setup, turn ON the power

supply again.

21



7. Serial Communications Connection Procedure

| 7.3 PLC setup
Set up the PLC.

7.3.1. Hardware Settings
Set the hardware switches on the Serial Communications Unit and connect the cables.

IE' Precautions for Correct Use

Make sure that the power supply is OFF when you set up.

If it is ON, the settings described in the following steps and subsequent procedures may not
be applicable.

1 Make sure that PLC is powered

OFF.
2 Check the positions of the S%d‘ﬁ —
hardware switches and Port 2 2223°F % Indicators
on the front panel of Serial Terminating
S . / resistance switch
Communications Unit by "~ Unit number
referring to the figure on the __ Switch
. - 2-wire/4-wire
right switch
| Port 1:
RS-422A/485
terminal-block
connector
/O\“ PORT2
— Port 2:
RS-232C

3 Set Unit number switch to 0.

*The unit number is set to 0 as
the factory default setting.

4 Connect Serial Communications

Unit to PLC as shown on the Personal PLC r Se”%rfi’t"mm“”icaﬁons
right. computer
€= End cover

Connect Power Supply Unit to
Port 2 on Serial USB cable
Communications Unit with the

Serial cable (RS-232C).

Serial cable (RS-232C)

I
Power Supply Unit

t7

Power Supply Unit CPU Unit

Connect Personal computer to
PLC with a USB cable.

Image Reader

Turn ON PLC and Power Supply
S Unit.

22



7. Serial Communications Connection Procedure

7.3.2. Starting CX-Programmer and Going Online with PLC
Start CX-Programmer and go online with the PLC.
Install CX-One and the USB driver on your personal computer beforehand.

1 Start CX-Programmer.

*If the User Account Control
Dialog Box is displayed at start,
make a selection to start
CX-Programmer.

2 CX-Programmer starts. X Program =

Ele Miew PLC Tools Help
DeHk(ek s en(@|ac haensoee||asns s
sgaaligEEREE|R trirw ) —coFFEL ||

3 Select Auto Online - Direct [PLC]| Tools Help

Online from the PLC Menu. | ETICHEINN % F

] %, CP1L-Ethernet Online
LR | - S [ & EtheNet/P Node Online

L o =

4 The Direct Online Dialog Box is ' SO
displayed. 1

Select USB connection as the Goes online automatically.
. Select connection type and press [Connect] buttan.
connection type.

Click Connect.

— Connection Type

Senal connection
[alzo when uzing USE-Serial conversion cable]

Serial port of PC

|com1 =l
¥ Conmects at baud rate 115,200 bps
& LSE conmection

— Connecting PLC series
[T Marrow down PLE series to connect

{ CS/CI/CP series, M5 zeres
OOV series
= C series (include CPRY)

Connection will automatically be made to the PLC connected directly to
the PC wvia USE cable.

Fleaze select ""'Seral connection
cable.

when uging USE-Serial conversion

Connect Cancel |

23



7. Serial Communications Connection Procedure

The dialog box on the right is
displayed. Check the contents
and click No.

Do you wish to transfer program from the PLC after onlined automaticalty?

[~ Transfer 10 table and Special Unit Setup

The dialog box on the right is
displayed.

CX-Programmer and PLC are
automatically connected.

Fruto Online(Searchindl

PLE: FJZ.-"CF‘INSJ Series

Communication |LISB
Settings:

Protocal; |LISB

Check that CX-Programmer and
PLC are online.

*The & icon is pressed down
during online connection.

88 - CX-Programmer - [[E4T] - $4EPLC1.3787° 00 501005301 [55° -3 £=s
[ 7r(E) #E(E) TR #BAQ) PLCC) 707(R) 3E-aEy(S) $MI) ngw) ar(H) [ =[x

DSE R &R e (e o a=m ot |(a)sss|s

a o Q@ [ R e R Ay ur e —Oﬁﬁ"’ﬁTEI—'xH]IE\

Additional Information

If the online connection to the PLC cannot be established, check the cable connection.
Or, return to step 1, check the settings and repeat each step.

For details, refer to Connecting Directly to a CJ2 CPU Unit Using a USB Cable of the
CX-Programmer OPERATION MANUAL (Cat. No. W446).

Additional Information

The dialog boxes described in subsequent procedures may not be displayed depending on

the environmental settings of CX-Programmer.

For details on the environmental

settings, refer to Options and Preferences in CHAPTER 3

Project Reference in PART 1: CX-Programmer of the CX-Programmer OPERATION
MANUAL (Cat. No. W446). This guide explains the setting procedures when "Confirm all
operations affecting the PLC" is selected.
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7. Serial Communications Connection Procedure

7.3.3. Creating the I/O Table
Create the I/0O table for the PLC.

1 [fthe operating mode of PLC is o
Run Mode or Monitor Mode, E-48 NewProject
change it to Program Mode by E'ﬁ _r\f”:pll‘ci[gm

following the steps below.

File Edit View Insert Program  Simulation Tools Window Help
0OE e |I3@ |§ [@work Online cew | | @ 7N

Auto Opline L4

(1)Select Operating Mode -

Program from the PLC Menu 8 KQAR |G ey ~r —
. erating Mode Elo ram Ctrl+1
in CX-Programmer. mERED Mmto, , é

'@ Moniter  Ctrl+3

- ¥4 Compile All PLC Programs 7]
E--% MNewProject & (s .g @; Run Ctrl+4
i B8 el F1TC 104 Program Check Options...

(2)The dialog box on the right is
displayed. Confirm that there

IS No prOblem’ and click Yes. o Make sure that there aren't any problems if the PLC is stopped.
JA Do you wish to switch the PLC into program mode?

*Refer to Additional Information
on the previous page for the
settings concerning the dialog
display.

(3)Check that Stop/Program | x|
Mode is displayed to the right =% NewProject

of the PLC model in the :
Project Workspace of E"'ﬁ NEWPLCI[CJEM]
e ®® Data Types

CX-Programmer.

----- = Symbols
(Project Workspace)
2 SeleCt Edlt - I/O Table and Unlt Eile Edit View [Insert |PLC | Pregram Simulation Tools Window Help
Setup from the PLC Menu in DS M|k & IE‘;—V‘Z*SHI'}"E cw o e N Jales|a|=
- = e - L
CX-Programmer. TN e b —opEERL K|
'EE@EH: Maonitor ’g‘

=% NewProject ¥ Compile All PLC Programs 7]

Eﬁ NewPLCL[CI2M Program Check Options...
™% Data Types Program Assignments

-5 Symbols Memory Allocation r
7 10 Tabi

Setta e an Transfer »
ings

=] Mamugry car Partial Transfer »
[y Error log Protection »
Llear EMo| reas

(&) PLC Clock Clear All Memory A

gt Memory
Information
=R YProgram:| _ ; —
4l NewProd  Change Model 310 Table and Unit Setup

The PLC 10 Table Window is
displayed.

Eile

B @R« &|nle] 2|7 Blelels] o]

Edit Miew Options Help

--h Inner Board
w44 [0000] Main Rack
--ﬁ [0000] Rack 01 I
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M Precautions for Correct Use

7. Serial Communications Connection Procedure

The PLC will be reset after creating and transferring the 1/O table in step 3 and subsequent

steps. Always confirm safety before creating and transferring the 1/O table.

3 Select Create from the Options
Menu of the PLC IO Table
Window.

The dialog box on the right is
displayed. Confirm that there is
no problem, and click Yes.

The dialog box on the right is
displayed. Confirm that there is
no problem, and click Yes.

4 The Transfer from PLC Dialog
Box is displayed. Select 10
Table and SIO Unit Parameters.
Click Transfer.

When the transfer is completed,
the Transfer Results Dialog Box
is displayed.

Check that the transfer is
successfully completed by
referring to a message in the
dialog box.

When the I/O table is created
normally, the dialog box displays
as follows:

Transfer Success: 1 Unit
Transfer Unsuccessful: 0 Unit

Click OK.

| 9% PLC IO Table - NewPLC

Eile Edit View | Options

Transfer to PLC
Transfer from the PLC
Compare with PLC

o] CJ2M-CPU]
--q Inner Boar:
w44 [0000] Mai
- 4, [0000] Rac

Create

kL Initialise CPU Bus settings ?

I Transfer from PLC

Select the transfer target data and press the [Transfer]
button.
Comment irformation is deleted i 10 Table is transfemed.

[v 10 Table

[v SIO Unit Parameters

i Transfer Results

<|0 Table>
Transfer Success

<Special Units settings =
CPU Bus UnitDD: Transfer Success

Transfer Success:1 Unit  Transfer Unsuccessful:0 Unit
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7. Serial Communications Connection Procedure

7.3.4. Parameter Settings
Set the parameters for the Serial Communications Unit.

Double-click [0000] Main Rack o e 10 1ote - oo T e e ]|
§7 PLCIO Table - N (|l S e e
in the PLC 10 Table Window to R

expand the tree.

File Edit View Options Help

& sl &|=e o)k lddles |
- CJ2M-CPU12
--q. Inner Board

=X 1 [0000] Main Rack

;1 00 [1500] CHW-5CU42(Sernal Communication Unit) (Unit: 0)
‘. 3] 01 [0000] Empty Slot

2 Right-click 00 [1500]
CJ1W-SCU42 and select Unit

9 \ (=)

Eile Edit View Options Help

Setup.
& S&lw &|me| (2 bdble Kl ]
----- 7l C2Mm-cru12
[+-dtgy Inner Board
=14 [0000] Main Rack
----- W 0100  AdduUnit
..... E: g; {gE Change / Confirm Units
..... 11 04 [0 Change Unit Mo
..... g
..... 5 0500 Unit Comment
----- i aster 4
= 06 [0C SYSMAC BUS M
----- s 07 [0C _
_____ ﬂ DE [nc Uﬂlt SEtL_IFI'
..... 09 100 ave Parameters
| [ Save P
3 The View Parameters Dialog CILW-SCU42 [View Parameters
Box is displayed. Select Port2:
. . Displayed Parameter |All Parameters
Host Link Settings from the Al Parameters
i i o ponz St
- [+] Ings
pull down IISt Of Dlsplayed Port1: Port seftings  [Port1: Host _?Jnk Seﬂings
Parameter Port1: Serial commu E"ﬂ mTl';'r:': Se?ggf.
’ Paort1: Data length P:Iﬂ; Pr‘::toco?;‘;u‘o SIZig'tisngs
Paort1: Stop bits Port1: Seral Gateway Settings
. . . . Port1: Parity Port1: Loopbacktest Settings )
*This setting is required to use Port!: Baud rate
Port 2 of Senal Port1: Send delay  Port2: NT Link Settings
. . . Port1: Send delay (ug PortZ: No-Frotocol Settings ms
Communications Unit. Fortl- GTS conrol | Po"t2: Protocel macro Setings

Port2: Serial Gateway Settings
Port1: 1:NM:1 protoc Port2: Loopback-test Settings
Port1: Host Link com|Port2: MODBUS-RTU Slave Settings
Port1: Host Link unit number 0

Port1: Mo-Protocol Start code 0

Port1: No-Protocol End code 0

— Help

<Default >Default (3600bps)

<Address=Word:D30001, Bit:0-3
<Type:xList

TrangferlUntto PC] | TransfedPCto Unt] |  Compare |

Set Defaults |
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7. Serial Communications Connection Procedure

4 The setting items of “Port2: Host
Link Settings” are listed as

CIIW-3CU42 [View Paramete|

shown in the figure on the right. Displayed Parameter v
ltermn Set Value Unit
Pon2: Port settings Defaults
Port2: Serial communications mode Host Link({default)
Por2: Data length 7 bits
Portz: Stop bits 2 bits
Por2: Parity Even
Port2: Baud rate Default{9600bps)
Por2: Send delay Default (0 ms)
Port2: Send delay (user-specified) 0 ms
Port2: CTS control Mo
Port2: 1:N/M1:1 protocol setting 1:M protocol
Port2: Host Link compatible device mo | DefaultiMode A)
Port2: Host Link unit number 0
5 Select User settings from the CJIW-5CU42 [View Parameters] .
pull-down list of Set Value for
“Port2: Port Settings”. Displayed PammaterlPortZ: Host Link Settings ;I
Item SetValue Unit
Port2: Port settings =~
Port2: Serial communications mode Defaults
Portz2: Data length er Sefng
Por2: Stop bits 2 bits
Port2: Parity Even
Port2: Baud rate Default(9600bps)
Por2: Send delay Default (0 ms)
Portz: Send delay (user-specified) 0 ms
Port2: CTS control Mo
Port2: 1:Mi1:1 protocol setting 1:M protocol
Port2: Host Link compatible device mo | DefaultiMode A)
Port2: Host Link unit number 0

6 Set the following parameters in
the same way as step 5.

Serial communications mode:
Host Link(default)

Data length: 8 bits

Stop bits: 1bit

Parity: None

Baud rate: Default(9600bps)

CTS control: No

1:N/1:1 protocol setting:
1:1 protocol

*Use the default settings for
other parameters.

Click Transfer[PC to Unit].

CIIW-5CU42 [View Parameters:

Displayed Parameter |Port2: Host Link Settings

Itermn

SetValue

PortZ; Port settings

User settings

Port2: Serial communications mode

Host Link{default)

Paort2: Data length

2 bits

Port2: Stop bits

1 bit

Port2; Parity

Mone

Port2: Baud rate

Default(9600bps)

PortZ: Send delay

DT [ sy

Port2: Send delay (user-specified)

0

Port2: CTS control

Mo

Paort2: 1:MM:1 protocol setting

1:1 protocol

Port2: Host Link compatible device mo

Default(Mode A)

Port2: Host Link unit number

0

<Default >Defautts

<Address>Word:D30010, Bit:15
<TypexList

Transfer{Unit to PC] | I Transfer[PCto Unit] I Compare

Set Defaults |
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7. Serial Communications Connection Procedure

7 The dialog box on the right is
displayed. Confirm that there is
no problem, and click Yes.

Check that the transfer is
completed as shown on the
right. Click Close.

& Downloads parameters to the unit.
Lk Are you sure you want to continue?

& o

[Transfeming parameters (PCto Unit)

Edit Parameters

L —
ITransfer successful

8 The dialog box on the right is
displayed. Check the contents
and click Yes.

The Select Port Dialog Box is
displayed.
Select All ports and click OK.

@y ltis necessary to restart the unit to transfer the setting effectively.
W' Do you wish to restart the unit?

Select a port to restart from the list below

ostLin
HostLink2

The dialog box on the right is
displayed. Check the contents
and click OK.
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7. Serial Communications Connection Procedure

" CILW-5CU42 [View Para

10 Click Compare in the View
Parameters Dialog Box.

Displayed Parameter |Port2: Host Link Settings

Item SetValue
: Port settings User settings
: Serial communications mode Host Link{default)
- Data length 8 bits
- Stop bits 1 bit
- Parity Mone
- Baud rate Default(9600bps)
- Send delay Default (0 ms)
. Send delay (user-specified) 0
: CTS control Mo
- 1:Mi1:1 protocol setting 1:1 protocol
- Host Link compatible device mo | Default{Mode A)
: Host Link unit number 0

«Default >Defaults

<Address>Word:D30010, Bit:15
<Type>List

-

Transfer{Unit to PC] | | TransferiPCto Uni] | [~ Compare |

Set Defaults |

11 Check that a message stating
"Compare successful” is
displayed in the dialog box on

the right.
Click Close.

12

Click OK in the View
Parameters Dialog Box.

" CILW-5CU42 [View Para

Displayed F'Euan'leterlF‘ortZ: Host Link Settings

ltem

SetValue

Read Value (Compare

. Port settings

User settings

User settings

: Serial communications mode

Host Link{default)

Host Link{default)

- Data length

8 bits

8 bits

: Stop bits

1 bit

1 bit

- Parity

MNone

MNone

: Baud rate

Default(3600bps)

Default(2600bps)

. Send delay

Default (0 ms)

Default (0 ms)

: Send delay (user-specified)

0

0

: CTS control

Mo

Mo

- 1:Mi1:1 protocol setting

1:1 protocol

1:1 protocol

- Host Link compatible device mo

DefaultiMode A)

DefaultiMode A)

:Host Link unit number

0

0

<Default >Defautts

<Type=List

<Address>Word:D30010, Bit:15

Transfer[Unit to PC] | Transfer[PCto Unit]

Set Defaults |




7. Serial Communications Connection Procedure

13 Select Exit from the File Menu
of the PLC 10 Table Window to

} PLC IO Table - NewPLC:

[Fie]

i't View Options Help

close. CPS Install... 2| 3|2 BB e % il 2
Print

Print Preview
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7. Serial Communications Connection Procedure

I 7.4. Serial Communication Status Check

Confirm that serial communications and PLC link for Image Readers perform normally.

7.4.1. Checking the Connection Status
Check the connection status of serial communications.

1 Check with LED indicators on Serial
Communications Unit that serial
communications performs normally.

The LED indicators in normal status
are as follows:

RUN: Green lit

RDY: Not lit

ERC: Not lit

ERH: Not lit

SD1: Not lit

SD2: Not lit

TER1: Not lit

SD2: Yellow flashing

RD2: Yellow flashing

RUM ERC 501 RD1 TER
| O O O O

] = = 3
ROY ERH SD2 AD2

TERM
OFF

[WIRE

T 1o

&)

2

=y 7o

)

ey

M

o\ UNIT
O
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7. Serial Communications Connection Procedure

7.4.2.

Checking the Sent and Received Data

Check that the correct data are sent and received using PLC link for Image Readers.

Window.

the Ladder Section Window or when monitoring present values in the Watch

Always ensure safety before monitoring power flow and present value status in

If force-set/reset or set/reset operations are inadvertently performed by pressing
short-cut keys, the devices connected to Output Units may malfunction,
regardless of the operating mode of the CPU Unit.

1 Check that the operating mode of
PLC is Stop/Program Mode.

*If the operating mode of PLC is not
Stop/Program Mode, change to
Stop/Program Mode by referring to
step 1 of 7.3.3. Creating the 1/0O

=l xl

E--% MewProject
B-fF NewPLC1[CIZM
...™® Data Types

Stop/Program Mode

Table.
2 Se|eCt Ed|t _ MemOI’y from the PLC Insert Program  Simulation  Tools Window Help
IR & Work Online Ctrl+W o 7 e &l 8 w3,
Menu. Auto Online ’
g — oG EEEL K |
Operating Mode L4
& Manitor 4
[#¥ Compile All PLC Programs F7 Trtegemt]
2M] Me Program Check Options... el
ec Program Assigm."nents L
Memaory Allocation 4 [ FEEF@TTY [ &o000T
1 Locsl G i
] U s catiensinFroe..
card Partial Transfer 4
Protection 4
k Clear All Memory Areas
Edit 4 Information
rogram Change Model #7T /0 Table and Unit Setup
mbols Change Communication Settings Settings

art_Set Ly Data Trace...
pen_Pro

1gin_Prg

:nd_Pro Force
Set

=ceive_F

Time Chart Monitoring...

[=] Memory Card

Memory Cassette/DM

Rezet CP1L Built-in Ethernet Port

> [ Error Log

sgout_Processing
ose Processing

S
Clock

Expansion Instructions

3 The PLC Memory Window is
displayed. Double-click D on the
Memory Tab of the PLC Memory
Window.

Eile Edit View Grid Online Window Help

Ble|d| SR &[%[@|

il Cam - cPui2

°l=

Lo EO

Ready

" g Memory [E> Address

N 1 ) i = R S eV e s P
=l x|

D =1 §oH =)
Start Address 0 \ \ \
| o1 | 2| 3| 4| 5| 46| 57| 8| 19| =
D00000
D00010
D00020
D00020
nnnnan SZ
Do CJ2M - CPU12 Monitor NUM
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7. Serial Communications Connection Procedure

4 Select Display - Hexadecimal from  [Vieu| 6rid Online Window Help

the View Menu. Atways On Top | 2208 o] BcR
Toolbars...
Q

v Status Bar

v Data Area WorkSpace =
Display » Binary
ZoomIn Ctrl+PgDn Binary Coded Decimal
Zoom Out Ctrl-Pglip D:enmal )
100% Signed Decimal

Floating point

Resize Columns -
*  Hexadecimal

Preferences... Text
5 Select Monitor from the Online [ Online | Window Help

Menu. Transfer To PLC...
3 Transfer Erom PLC...
Lompare With PLC...

Manitor

6 The Monitor Memory Areas Dialog  ["Monitor Memory meas- |25

Box is displayed. —
Check that D is selected. D) | Monitor

Click Monitor. Cancel |

7 Enter 1000 in the Start Address

. . Gt D =

Field of the D Window. B8 BB
statAddress|  1000] o0 | o | Setvae |
ChangeDlderl Forceln | Forcelff | ForceCanc |

Check that the start address 0 1| 2] 3] 4| +5 | 6| +7 | 8| +0 | »

ChangeS tO D01000 @[H u@ 0000 | o000 | OOO0O | OOOO | OOOO | OOOO |OOOO | OOOO |O0O0O | OOOO I:I

DO7070 | 0000 |0o0C | cooo |oooo |ocoo | oooo |oooo | oooo |ocoo | oooo
001020 | 0000 | 0000 | 0000 (0000 | OOOO | 0000 | 0000 | 0000 | 0000 | 000D
001030 | 0000 | 0000 | 0000 (0000 | QOOO | 0O0OQ | 0000 | 0000 | 0000 | 000D
001040 | 0000 | 0OCO | 0OOO | OOOO | OOOO | OOOO | 0000 | OO0 | OOOO | OOOO | —

J: Ond0ff,  T: ChangeOrder
Ctil+J: ForceOn, Chl+: ForceQff, Chl+l: ForceCancel
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7. Serial Communications Connection Procedure

8 Click SetValue. Start Address: [ 1000 on | off “ SetValue

EhangeDrderl Forceln I Forcelff I ForcelCanc

The Set Value: Hexadecimal Dialog
Box is displayed.

Set Value: Hexadecima

—Range
Oto FFFF

o] Place Image Reader at the position
where it is able to read the 2D code
"ABCDE12345" (ASCII code) shown
on the right.

3 £ &

"ABCDE12345" (ASCII code)

10 Enter 1 in the Value Field of the Set
Value: Hexadecimal Dialog Box.

Set Value: Hexadecima

—Value

Click OK. [

—Range
Oto FFFF

The value of D01000 changes to TR

0001. Do 000 000 | 0000 | o000
DOlO1 0 | ooog | o000 | o000 | oooa

*The Image Reader starts reading
the 2D code.
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7. Serial Communications Connection Procedure

11 One short buzzer of Image Reader
rings when the 2D code reading is
completed.

*If Image Reader is unable to read
the 2D code, check the cable
connection and the position where
Image Reader is placed to read the
code, and perform steps 9 and 10
again.

For details, refer to 10.
Troubleshooting of the Operation
Manual MVF-300 Series Fixed
mount 2D Image Reader *

Edition.
12 The value of D01000 changes to — e
0000. Start Address:| 1000 | | setvae |
The number of digits of read data is | | |
stored in D01009, and the read data 0| | 2| 3| sa]| 5| 6| 7| 8] 0] -
. Do1ogo (0000 pOOOO | 0000 | 0OOO | 0000 | 0OOO | OOOO | OOCO | OOO0O0 QOO00A
are stored in D01010 onward, as DO1010 (4142 | 4344 | 4531 | 3233 | 3435 [JI000 | 0000 | 0000 | 000D | 000D
Shown beIOW. Do1020 | 0000 | OOOC | OOOO |OOCO | Q00O | OOOO |0COO |OO0CO | OOOO | OOOO
The number of digits of read data: e
000A (10 digits) Grid Online  Window Help
Read data: | AwaysOn Top
4142 4344 4531 3233 3435 ‘/ ;Z'u*’:é: Lﬂ 2 5
| ¥ Data Area WorkSpace I
Select Display - Text from the View Display 3 Binary
Menu, to display the read data in ZoomIn Ctrl+PgDn Binary Coded Decimal

Decimal

text format. Zoom Out Ctrl-PgUp

100% Signed Decimal
Floating point

Resize Columns * Hexadecimal

Preferences... Text
Ny W
The followi t
| e following 'reafj d.a a are <D —r

displayed, which indicate that the

Start dddress: 1000 | | Setvalue |
2D code has correctly been read in | | |
Step 9 +0| +1| #2| +3| +4| +5| +6| +7| +83| +9 -~

Read data: AB CD E1 23 45 001000 | == L |-
DO AB| CD|ET1 (23|45 .. |- |- |-
DO1020 | .. [ 11— - |- |- |- |- |- -
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8. Initialization method

8.

Initialization method

The setting procedures in this guide are based on the factory default settings.

Some settings may not be applicable unless you use the devices with the factory default

settings.

I 8.1. Initializing a PLC

To initialize a PLC, it is necessary to initialize a Serial Communications Unit and a CPU Unit.
Change the operating mode of the PLC to PROGRAM mode before the initialization.

8.1.1. Serial Communications Unit

To initialize a Serial Communications Unit, select Edit - I/O Table and Unit Setup from the

PLC Menu in CX-Programmer and perform the following steps.

(1)Right-click Serial Communications Unit in the PLC IO Table Window and select Unit Setup
from the menu.

7 C2M-CPU12
-” Inner Board

2-&§ [0000] Main Rack

?' 01 [0000 Add Unit
- % 02 [0000 Change / Confirm Units
-5l 03 [0000 Change Unit Ne

¥ 0410000 Unit Comment
-4 050000

# 06 (0000 SYSMAC BUS Master
-1 07 (0000 Unit Setup

5 08 [0000

d nomnan Save Parameters

(2)In the CJ1W-SCU42 [View Parameters] Dialog Box, click Set Defaults first, then click
Transfer[PC to Unit].

Displayed Parameter |AII Parameters

Item

Set Value

Fort1:

Port seftings

Defaults

Forti:

Serial communications mode

Host Link(default)

Port1:

Data length

7 bits

Port1:

Stop bits

2 bits

Portt

: Parity

Even

FPort1:

Baud rate

Default{9600bps)

Fort1:

Send delay

Default (0 ms)

Fortl

: Send delay (user-specified)

0

Port1:

CTS control

Mo

Port1

2 1:NM:1 protocol setting

1:M protocol

Port1:

Host Link compatible device mo

Default{Mode A)

Fort1:

Host Link unit number

0

Fort1:

Mo-Protocol Start code

0

Port1:

Mo-Protocol End code

0

Help

Transfer{Unit to PC] | I Transfer[PC to Unit] I Compare

Set Defaults
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8.1.2.

CPU Unit

8.

Initialization method

To initialize a CPU Unit, select Clear All Memory Areas from the PLC Menu in
CX-Programmer. Select Initialize in the Confirm All Memory Area Clear Dialog Box and click

OK.

Confirm All Memory Area Clea

—Clear all Memary Areas

This function will initialize the following target area of
PLC. After checking the target area, select ‘Intialize”
and press O,

PLC Mame |NewF‘LC1

PLC Type FJEI'H'I-CF‘U'IE

Target Area Program Area

100 Area
Parameter Area
-PLC Settings fArea
-Perpheral Device Area
-0 Table Area
-Routing Table Area
=510U CPU Unit Area

[ Clear Emor Log

@ Griain

Do not intialize
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8. Initialization method

I 8.2. Initializing a MARS TOHKEN SOLUTION Image Reader
Take the following steps to initialize a MARS TOHKEN SOLUTION Image Reader.

1 Connect Image Reader to Power
Supply Unit with the Image
reader cable and Image Reader
to Personal computer with the
LAN cable for MVF series.

2 Turn ON Power Supply Unit.

3 Start MVFConfig on Personal

computer. Elw

MVFConfig
4 Perform steps 4to 7 in 7.2.2.
Parameter Settings.
Check that the B mark © Register @ Delete % Connect $$ Disconnect
(connection status) is displayed

. Status Reader Name Address
in the Status Column of Image

Reader as shown on the right.
5 Select Restore Default Settings Reader View System Tool

from the Reader Menu. X Read Config Ctrl+F1
X Write Config Ctrl+F2
. Save Config Ctrl+F3
B®  Symbol 3
) Restore Default Settings Ctrl+F4
) Restore Lan Seffings Ctrl+F5

6 The dialog box on the right is
displayed. Check the contents
and click Yes.

Restore the default settings of the scanner.
Are you ok?

7 The dialog box on the right is
displayed. Check the contents
and click Yes.

Load configuration from the scanner?
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8. Initialization method

8 Select Save Config from the —— m— — ool
Reader Menu. ;]

& Read Config Ctrl+F1

*If you do not save the X Write Config Ctrl+F2
configuration, the data

configured on Image Reader o Save Config Ctrl+F3

are not stored in the
non-volatile memory of Image
Reader, and they will be
discarded when you turn OFF
Power Supply Unit.

o] The dialog box on the right is
displayed. Check the contents
and click Yes.

Save configuration to the scanner?

@ Additional Information

If the IP address of the Image Reader is unknown, first take the following steps to initialize the
LAN settings of the Image Reader, then perform initialization of the Image Reader as
described in this Clause 8.2.
1. Turn OFF Power Supply Unit.
2. Turn ON Power Supply Unit while pressing the Teach Key on the operation panel of
Image Reader.
Teach Key

Operation panel of Image Reader

40



9. Revision History

9. Revision History

Revision Date of revision Description of revision
code
01 May 11, 2017 First edition
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